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Android Studio でのアプリ開発



発展学習について

本資料は、勉強会資料の側面として、
 画面上部のタイトル左端に　　 を記した

発展学習ページも設けています。

演習作業の合間に
余裕があれば、参照ください。

発展
学習



　
Android Studio での機能別ウィンドウやバーの一般的な呼称（一般名称）
Android Studio を大勢の人と使う上で、意思疎通がしやすいようバーやウィンドウの一般名を示します。

 

ここで明示した各部位の名称は、一般的な用法に合わせていますが、本勉強会用の名称（用語）です。

Android Studio の予備知識

ナビゲーション・ツールバー

メニュー・バー

ナビゲーション・バー

左ツールウィンドウ・バー

左ツールウィンドウ

ツールウィンドウ・バー

ステータス・バー

ツールウィンドウ・ボタン

右ツールウィンドウ

右ツールウィンドウ・バー

マーカー・バー
 

エラーやTODOマークを表示

ドキュメント・タブ

ガーター・エリア

エディタ・エリア (Editor)

ツールウィンドウ

発展
学習



　Android Studio ナビゲーション・ツールバーの機能ボタン概要（１）

Android Studio の予備知識

１つ前の操作
に戻ります

１つ先の操作
に進みます

プロジェクトを
ビルドします

モジュール
通常実行

モジュール
デバッグ実行

実行モジュールの 
選択と設定をします

発展
学習



　Android Studio ナビゲーション・ツールバーの機能ボタン概要（２）

Android Studio の予備知識

設定ダイアログを開きます
（プロジェクトやIDEの設定用）

プロジェクト構成
設定ダイアログを開きます。

AVDマネジャを
開きます。

DDMSを
開きます

プロジェクト構成設定と
Gradle設定を同期させます

SDKマネジャを
開きます。

発展
学習



　Android Studio のツールウィンドウ開閉
 

１. メニューバーから開閉する
 メニューバー > View > Tool Windows で

指定のツールウィンドウが開閉します。
 
2. ツールウィンドウ・バーから開閉する

ツールウィンドウ・バーのツールウィンドウ・ボタンで、
指定のツールウィンドウが開閉します。

Android Studio の予備知識
発展
学習

開閉が切り替わる



　Android Studio のツールウィンドウ開閉
 

3. ツールウィンドウ・メニューから開く
ステータス・バー左端の        アイコンの
マウスオーバ・メニューから、
指定したツールウィンドウを開きます。

 

上記アイコンをクリックにすると、
ウィンドウツールバーが開閉します。

4. Hide アイコンで閉じる
ツールウィンドウ右上の        アイコンの
クリックでツールウィンドウが閉じます。

Android Studio の予備知識
発展
学習

マウスオーバーで、
メニューが開きます

アイコンクリックで
ウィンドウツール・バーが

開きます 

アイコンクリックで
ウィンドウツール・バーが

閉じます 



アプリ開発入門

Android Studio でのアプリ開発



　演習１）の目的
アプリ開発（言語習得）の第一歩として、Hello World アプリ作成があります。

 この演習では、自分で新規プロジェクト（Hello World  アプリ）を作成してもらい、
エミュレーターで実行してもらうことで、アプリ開発の第一歩を踏み出してもらいます。

 演習１） 新規プロジェクトを作ってみよう



　Hello World  アプリの作成 （新規プロジェクトの作成）
 

1. プロジェクト新規作成の実行
Android Studio  の起動画面の Quick Start 
から、New Project をクリックします。
 

2. 新規プロジェクトの基本設定（１）
Create New Projcet ウィンドウが開くので、
１．Application Name  を
　HelloWorldApplication に変更し、
２．Company Domain を
　helloworld.example.com に変更し、
３．Project location を
　C:￥Users￥ユーザ名￥AndroideStudioProjects
　￥HelloWorldApplication （一行）に設定し、
　※AndroideStudioProjects は、Android Studio の

　※標準のプロジェクトディレクトリ名です。

４．「Next」をクリックして次に進みます。

新規プロジェクトの作成



　3. 新規プロジェクトの基本設定（２）
 

１．Phone and Tablet   の Minimum SDK  を
　勉強会の対象最小Androidバージョンとなる
　API 15 （Android 4.0.3 ICS  ）に変更し、
 

２．「Next」をクリックして次に進みます。

新規プロジェクトの作成



　4. 新規プロジェクトの基本設定（３）
１．Activity 表現タイプを
　Blank Activity with Fragment に指定し、
２．「Next」をクリックして次に進みます。

5. 新規プロジェクトの基本設定（４）
１．Activity Name  を
　HelloWorldActivity に変更し、
２．Layout Name を
　activity_hello_world に変更し、
３．Fragment Layout Name を
　fragment_hello_world に変更し、
4．Title  を
　HelloWorldActivity に変更し、
5．「Next」をクリックして次に進みます。

新規プロジェクトの作成



　6. 新規プロジェクト生成
以下のような流れで、基本設定に従った
Hello World プロジェクトが生成されます。
 

１．Gradle Build プログレスが表示され
　Hello World プロジェクトの新規生成が
　始まり、
 

 ２．新規生成した Hello World プロジェクトを
 　オープンした Android Studio が開きます。

　（この例では、Tip ダイアログを伴っています。）

新規プロジェクトの作成



　Hello World アプリの内容確認

発展学習として、生成されたプロジェクト

内容を確認してみましょう。

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
1. app/main/java/

com.example.helloworld.
Helloworldapplication/
HelloWorldActivity.java
Activty処理内容の定義
（画面処理内容の定義）

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
2. app/main/res/layout/

activity_hello_world.xml
Activity画面内容の定義
画面全体の表示内容定義

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
3. app/main/res/layout/

fragment_hello_world.xml]
Fragmentによる画面内容の定義
画面表示内容パーツの定義
（Activity画面内容の部分参照パーツ）

新規プロジェクトの作成
発展
学習



　

新規プロジェクトの作成
発展
学習

Hello World アプリの内容確認
   4. app/main/res/values/

dimens.xml
定数リソースの定義



　

新規プロジェクトの作成
発展
学習

Hello World アプリの内容確認
   5. app/main/res/values/

strings.xml
stringリソースの定義



　

新規プロジェクトの作成
発展
学習

Hello World アプリの内容確認
   6. app/main/res/values/

styles.xml
styleリソースの定義



　Hello World アプリの内容確認
   7. app/main/

AndroidManifest.xml
アプリ全体設定

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
   8. app/

app.iml
Android Studio  の基となった
IntelliJ  の appモジュール設定

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
   9. app/

build.gradle
Android Studio  ビルドシステムである
Gradle  の appモジュール・ビルド設定

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
  10. gradle/

gradle-wrapper.properties
Android Studio  ビルドシステムである
Gradleのラッパー設定
gradle-wrapper.jarは、ラッパーの実態

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  11. HelloWorldApplication.iml
Android Studio  の基となった

IntelliJのプロジェクト設定

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  12. build.gradle
Android Studio  ビルドシステムである
Gradleのプロジェクト・ビルド設定

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  13. settings.gradle
Android Studio  ビルドシステムである
Gradleのプロジェクト・モジュール設定

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  14. gradlew
Gradle起動シェルスクリプト（Linux用）

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  15. gradlew.bat
Gradle起動バッチスクリプト（Windos用）

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  16. gradle.properties

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認

  17. local.properties

新規プロジェクトの作成
発展
学習



　Hello World アプリの内容確認
実をいうと．．．
Android Studio には、プロジェクトの
アクティビティ表示内容の初期値として
Hello World表示が含まれています。

 　このため Hello World アプリは、

　すでに実装済みとなっています。

新規プロジェクトの作成



　Hello World アプリの実行
（アプリのエミュレータ実行）
 

1. モジュール選択確認

Android Studio 上部にあるナビゲーション・

ツールバーのモジュール選択リストボックスで、

ａｐｐモジュール（ドロイドくん＋app）を選択

します。

2. モジュール実行

Android Studio 上部にあるナビゲーション・

ツールバーの右向き三角アイコン（Run ‘app’）を

クリックして、app モジュールを実行します。

新規プロジェクトの作成



　3. アプリ実行のGradleタスク起動
前ページでアプリ実行が要求されたので
アプリ実行のGradleタスクが走りだします。

 

Android Studio 下部にるステータス・
バーにビルド・タスク進行が表示されます。

新規プロジェクトの作成



　4. アプリ実行デバイスの選択
実行準備が整えば、アプリ実行デバイスの
選択ダイアログが開きます。
 

　Choose running device は、
　アプリ実行デバイスとして、
　PCに接続された実機や、実行中のエミュ
　レータを選択する項目です。
 

　Lunch emulator は、
　アプリ実行デバイスとして起動する
　エミュレータを指定する項目です。
 

　ここでは、Lunch emulator で
　予め作成しておいたエミュレータ
　（Android_4.4.2）を選択してください。
 

アプリ実行するデバイスを選択しましたら
「OK」をクリックしてください。

新規プロジェクトの作成



　5. アプリ実行エミュレータの起動
前ページの操作で
アプリを実行するエミュレータが起動します。

エミュレータ起動には、時間がかかります。
起動が終了すると、ロック画面になるので、
手動でロックを外すと（鍵アイコンを右スライド）、
Hello Word アプリが実行されます。

新規プロジェクトの作成



　Hello Wordアプリ実行は、これで終了です。

発展学習として、Hello World アプリは、
画面に「Hello World!」と表示するだけですが、
Android では、たくさんの工程とソースファイルや
ビルド設定が必要となることを
もう一度御確認ください。

新規プロジェクトの作成
発展
学習



　プロジェクト画面のクローズ

（Welcome画面にもどる）
1. メニューバーからプロジェクトを閉じる

画面上部のメニューバーから
File > Close Project を選択して、
プロジェクト画面を閉じます。
 

（Welcome画面にもどります）

新規プロジェクトの作成

（１）メニューバー
      File 
       Close Project
        を選択

（２）プロジェクト画面が閉じ
       Welcome画面に戻ります



　Android Studio 終了

（IDEを終了させる）
1. メニューバーから終了する

画面上部のメニューバーから
File > Exit を選択します。

終了確認ダイアログが開くので、
「Exit」をクリックして、
Android Studio  を終了させます。

新規プロジェクトの作成

（１）メニューバー
     File 
      Exit
       を選択

（２）終了確認ダイアログが開くので
　　Exit をクリック

（３）Android Studio 終了



　Android Studio におけるプロジェクトと設定の保管先
Android Studio  を使ってみましたので 発展学習として、ユーザ・ホームディレクトリ内に保管される
Android Studio におけるプロジェクトの標準保管先と、設定内容の保管先を確認してみてください。

1. プロジェクトの標準保管先
Android Studio におけるプロジェクト一式は、標準設定だと

ユーザ￥アカウント名￥AndroidStudioProjects 以下に保管されます。
 （例） C:￥Users￥rie￥AndroidStudioProjects （【注意】ユーザ・アカウントID  ： rie が操作した場合）

2. Android Studio IDE の設定内容（Settings）の保管先

ユーザ￥アカウント名￥.AndroidStudioBeta 以下に保管されます。

　　　　　　　　（Settings  で指定した設定は、上記の config ディレクトリに保管されます）

  　　　　　　　　（一時作業ファイルなどは、 　上記の system ディレクトリに保管されます）
 （例） C:￥Users￥rie￥.AndroidStudioBeta （【注意】ユーザ・アカウントID  ： rie が操作した場合）

3. 【補足】Android Studio では、レジストリを使用しないそうです。

新規プロジェクトの作成
発展
学習



　Android Studio のプロジェクト・インポートについて
Android Studio では、外部で作られたアプリなどのプロジェクトを
自分のプロジェクトとして、取り込むことができます。

演習２）の目的
 この演習では、実際に意味のある挙動をしてくれる Android SDK に含まれるサンプル・プロジェクトを使い

 自分の Android Studio  にインポートした上で、アプリの挙動やソースの内容および Android Studio の機能を
自分の目と手を使って確認してもらいます。　（ソースプログラムのシンタクスやAPIの意味は、問いません）

 演習２） Example を動かしてみよう



　Android Studio のプロジェクト・インポートについて
 

プロジェクト・インポート時の注意事項
Android Studio  では、インポートするプロジェクトのフォルダ自体を Android Studio の所有物として扱います。

このためインポートしたプロジェクトの内容を変更すると、
インポート元のプロジェクト内容が変更されてしまいます。

インポート元のプロジェクト内容を保持したい場合は、
プロジェクトのフォルダ一式のコピーを作って、

 コピーしたフォルダのプロジェクトをインポートしてください。

サンプル・プロジェクトのインポート



　Android Studio のプロジェクト・インポートについて
 

インポート・プロジェクトのタイプ
Android Studio では、大きく分けて下記３つのタイプがあります。

（ライブラリなどのプロジェクトは、ここに含めていません）
 

１． Eclipse プロジェクト
Eclipse  用の スマートフォンまたはタブレットを対象としたプロジェクト

 

２． Android Studio mobile プロジェクト
Android Studio  用の スマートフォンまたはタブレットを対象としたプロジェクト

 

３． Android Studio Wear   プロジェクト
Android  Ｓｔｕｄｉｏ用のAndroid Wear 単独、

 または Android Wear + mobile（スマートフォン）を対象としたプロジェクト

現時点では制限がありますが、
Eclipse 用のプロジェクトであっても、Android Studio 用のプロジェクトに自動変換できます。

サンプル・プロジェクトのインポート



　Android Studio のプロジェクト・インポートについて
 

具体的なサンプル・プロジェクトのインポート手順例
１ . イ ンポート するサン プル・ プロジェ ク ト のコピー作成

Android Studio のプロジェクト標準保管先(*1)  に sample フォルダを作成し、
Android SDK 配置先(*2)  の sample￥androidバージョン  ￥ 下のサンプル・プロジェクトをコピーします。
 

(*1) ユーザ￥アカウント名￥AndroidStudioProjects 
 （例） C:￥Users￥rie￥AndroidStudioProjects （【注意】ユーザ・アカウントID  ： rie が操作した場合）

 

(*2)  Android Studio インストール先¥sdk
(例) C:¥Program Files¥Android¥android-studio¥sdk

２ ． プロジェクトのインポート
Welcome   画面の場合：Quick Start > Import Project
プロジェクト画面の場合  ：メニューバー > File > Project Import
両者いずれでもファイル・ツリーから、コピーしたサンプル・プロジェクトのフォルダを選択します。

サンプル・プロジェクトのインポート



　Android Studio のプロジェクト・インポートについて
 

（演習案）インポートするサンプル・プロジェクト
 

１． Eclipse プロジェクト
イ ン スト ール先\sdk\samples\android-19\legacy\NotePad
(簡易メ モ帳ア プリ )
(  遊べないのでデモと し て見る だけですが JetBoy も楽し いかも？ )

 

２． Android Studio mobile プロジェクト
イ ン スト ール先\sdk\samples\android-19\ui\BasicAccessibillity
(様々なUIの見本)

 

３． Android Studio Wear   プロジェクト
イ ン スト ール先\sdk\samples\android-20\wearable\Flashlight
(Android Wear単独のア プリ／左フ リ ッ ク する と 画面が明滅する だけのア プリ です)

サンプル・プロジェクトのインポート



　   インポート手順例 前半 （Eclipse プロジェクト）

サンプル・プロジェクトのインポート

1.Quick Start の
  Import Project を
  クリック

2.ファイルツリーが開くので
  Import する Project を
  選択し 「 OK」 を クリック

3.Import 変換出力先を指定
  標準ではAndroidStudioProjectsの

  下になります。

4.Ｅｃｌｉｐｓｅプロジェクトを

  Import する場合は、jarや

  ライブラリの変換を確認。

   (デフォルト指定で可)



　   インポート手順例 前半 （Android Studio mobile / wear プロジェクト）

サンプル・プロジェクトのインポート

1.Quick Start の
  Import Project を
  クリック

4.（ライブラリ変換なし）

  

3.（Ｉｍｐｏｒｔ 変換出力先指定なし）
  Import元を出力先に使います。

2.ファイルツリーが開くので
  Import する Project を
  選択し「OK」をクリック



　   インポート手順例 後半 （Eclipse / Android Studio プロジェクト）

サンプル・プロジェクトのインポート

６.Import 処理が始まります。
5.プロジェクトの基本設定の
  変換を行う場合は、確認が
  表示されます。
  （変換を行うので「OK」をクリック）

7.Import 処理終了



　Android Studio でよく使う設定
Android Studio  は、高機能な IDE （開発環境）ですが、標準では、いくつかの機能がオフに設定されています。
ここでは、サンプル・プロジェクトのソース確認や、アプリ開発時に役立つ代表的な設定を紹介します。
 

1. 行番号を表示させる。
メニューバー > File > Settings... > （Settingsダイアログ -IDE Settings-） Editor > Appearance 

 show line numbers (行番号表示) にチェックを入れます。
 

2. マウスオーバーで、Javadocをポップアップさせる。
メニューバー > File > Settings... > （Settingsダイアログ -IDE Settings-） Editor > 

-other- Show quick doc on mouse move (マウスオーバJavadoc表示) にチェクを入れます。
 

３. ショートカットキーを変更する（ショートカットキー設定一覧を確認する）
英語表記ですが、機能名とショートカットキー割当ての一覧が表示されます。
メニューバー > File > Settings... > （Settingsダイアログ -IDE Settings-） Keymap > 

Editor Actions や Main menu など （Main menuは、メニューバーへの割当）
虫眼鏡アイコンを利用すれば、機能名やキーによる項目検索もできます。

　  

サンプル・プロジェクトのインポート
発展
学習



　Android Studio でよく使う設定
 

4. TODOを明示する。
Pattern で指定したキーワードを先頭に持つコメントを青色で表示し、マーカーバーにマークをつけます。
またツールウィンドウ・バーの「TODO」をクリックすれば、TODOを検索結果一覧が表示されます。

 

メニューバー > File > Settings... > （Settingsダイアログ -IDE Settings-） TODO > 
標準で用意されている Pattern “￥btodo\b.” と “￥bfixme\b.” の Case Sensitive に
チェクを入れれば "todo” と “fixme” がTODOキーワドとして使えます。

（他にも便利な機能がありますので、御自身で Settings ダイアログを確認してみてください）

サンプル・プロジェクトのインポート
発展
学習



　Android Studio でよく使う設定

サンプル・プロジェクトのインポート
発展
学習

設定で
行番号が
表示されます

行番号を表示する



　Android Studio でよく使う設定

サンプル・プロジェクトのインポート
発展
学習

マウスオーバーでJavadocをポップアップする

メソッドやクラスなどでの

マウスオーバーにより

Javadocが表示されます



　Android Studio でよく使う設定

サンプル・プロジェクトのインポート
発展
学習

ショートカット・キーを設定する（一覧を確認する）
Main Menu は、メニュー・バーに相当します。

階層構造をたどれば、メニューから使える

各機能のショートカットが確認できます。



　Android Studio でよく使う設定

サンプル・プロジェクトのインポート
発展
学習

TODOを明示する
チェックによりキーワード

todo と fixme を有効化

TODOキーワード行が
（青く）明示されます

TODOキーワード行の
全体での位置がマークされます

TODO
ツールウィンドウでは、
キーワード行が一覧
検索されます。



　Android Studio でよく使うコードアシスト機能など
ここでは、サンプル・プロジェクトのソース確認や、アプリ開発時に役立つ代表的な機能を紹介します。
いずれもエディタエリアのソースコードを対象にした機能です。
 

1. カーソル位置キーワードのコード補完（候補一覧表示）
メニューバー > Code > Completion > Basic (ショートカット：CTRL + Space)

 

2. キーワードの宣言元/使用先の一覧表示
カーソル位置にあたるキーワードが使用されている箇所の一覧を検索して表示します。
ショートカット ：ALT+F7
右クリック・ポップアップメニュー ：Find Usage を選択

 

３ ． カーソル位置キーワードのソースへジャンプ
メニューバー > View > Tool Windows > Jump to Source (ショートカット：F4)
（標準設定では、メニューバーからの機能選択が非表示になっているようです）

サンプル・プロジェクトのインポート
発展
学習



　Android Studio でよく使うコードアシスト機能など
 

4． その他
メニューバーの Navigate 機能は、カーソル位置の状況に合わせて、
(宣言元や継承元など)目的先へのジャンプや、(継承関係などの)関係一覧表示などが行なえます。
Navigate > Type Hierarchy (ショートカット：CTRL + H) で、クラス継承構造の一覧表示など。

 
 

（他にも便利な機能がありますので、御自身で確認してみてください）

サンプル・プロジェクトのインポート
発展
学習



　Android Studio でよく使うアシスト機能

サンプル・プロジェクトのインポート
発展
学習

キーワードの宣言元/使用先の一覧表示

1.カーソル位置（例View）で
  ALT + F7 を実行
 

  （右クリックポップアップから
     Find Usage を実行）

2.カーソル位置キーワード（例View）の
  利用先一覧が検索されます。



　Android Studio でよく使うアシスト機能

サンプル・プロジェクトのインポート
発展
学習

カーソル位置キーワードのソースへジャンプ

カーソル位置（例Activity）で
F4を実行します。 ソース（定義元）が開きます。



　Android Studio でよく使うアシスト機能

サンプル・プロジェクトのインポート
発展
学習

クラス継承構造の一覧表示

2.カーソル位置キーワード（例View）の
  クラス構造(継承構造一覧)が検索されます。

1.カーソル位置（例View）で
  CTRL + H を実行
 

  （Navigate > 
  Type Hierarchy を実行）



　演習３）に進む前に

全体演習サンプル・プロジェクトのインポート
 

プロジェクトのインポートやソースの見方や触り方に慣れてもらったと思います。
以降の演習では、実際にコードを自分で書いたり変更したりして、動作を確認することで、
プログラミングへのより深い理解と学習成果を実感してもらいます。

ここで、以降の演習で利用する、
演習サンプル・プロジェクトをインポートしてください。
演習サンプル・プロジェクトは、以下のURLからダウンロードできます。

http://cch-lab.com/reference/AndroidBasicStudy_20141018/HelloPracticeApplication.zip

演習サンプルは、Hello World を少し改修しただけの簡単な内容です。

サンプル・プロジェクトのインポート

http://cch-lab.com/reference/AndroidBasicStudy_20141018/HelloPracticeApplication.zip


　ソースの入力や変更を行う演習サンプルをインポートされましたね。
オリジナルの HelloWorld アプリのメッセージは、"Hello world!"と英語でした。
演習の手始めに、メッセージを日本語にしてみましょう。

演習サンプル HelloPracticeアプリの画面表示を定義している、
app/src/main/res/layout/fragment_hello_practice.xml の Text タブを開いてください。

【指定ファイルを開く操作手順】
左ツールウィンドウの Project を開き、
HelloPracticeApplication プロジェクトのファイルツリーから、
app/src/main/res/layout/fragment_hello_practice.xml をダブルクリックします。

 

エディタエリアに fragment_hello_practice.xml が開きますので、
エディタエリア下部にある Text タブを選択してください。

 演習３） メッセージを変更してみよう



　

メッセージを変更してみよう

1.左ツールウィンドウの
  Project 

2.app/src/main/res/layout/
　 fragment_hello_practice.xmlを
　ダブルクリック 

3.fragment_hello_practice.xmlが
　 開くので、Textタブを選択 



　メッセージの変更(1)
 

1. TextView 要素の text 属性の内容を "@string/hello_world" から
"こんにちは、世界！"に変更してみてください。
 

TextViewの初期内容は下記の通りです
<TextView
    android:text="@string/hello_world"
    android:layout_width="wrap_content"
    android:layout_height="wrap_content" />

2. 右隣のPreview表示を確認します。
Preview は、Textで定義した画面内容をイメージ化するウィンドウです。
メッセージが、Hello world! から変化していることを確認できたでしょうか。
 

【学んだこと】
画面に文字を表示するには、TextView 要素を使います。
メッセージの内容は、text 属性に指定します。

メッセージを変更してみよう



　

メッセージを変更してみよう

1.text属性の内容を
　" ”こ んにちは、 世界！ に変更

2.メ ッ セージが"
”　こんにちは、世界！ に変わった

3.でも @stringリ ソ ースを使うべしと怒られた



　メッセージの変更(2)
 

1. Android Studio からの警告を確認する
マウスカーソルを text 属性の変更した内容に移動（マウスオーバ）してください
"should use @string resource"(@string リソースを使うべき)とポップアップされ
Android Studio から怒られることを確認します。

【学習ポイント】
@string リソースとは何か？
何故、怒られるのかを考えてみてください。

メッセージを変更してみよう



　メッセージの変更(2)
 

2. 変更を元に戻します
怒られたままでは嫌なので、変更を元に戻しましょう。
text 属性の内容を "@string/hello_world" に戻します。

 

右隣のPreview表示を確認します。
メッセージが、Hello world! に戻っていることを確認します。

 

【学習ポイント】
何故、表示が Hello world! に戻ったのか？
@string/hello_world の実態はどこにあるのかを想像してみましょう。

　勿体づけましたが、次のページから、
　@stringリソースの実態がどこにあるのか種明かしをします。
　それでは、 app/src/res/values/string.xml を開いて下さい。

メッセージを変更してみよう



　

メッセージを変更してみよう

1.text属性の内容を
　"@string/hello_world”に戻した

2.メッセージの内容も
　"Hello World!”に戻った

次ページから、
@stringリソースの実態の
種明かしです。



　

メッセージを変更してみよう

1.左ツールウィンドウの
  Project 

2.app/src/main/res/value/
  strings.xmlを
　ダブルクリック 

3.strings.xmlが
　 開きます。



　メッセージの変更(3)
 

1. Hello World! 定義元リソース
name 属性が hello_world の string 要素を見てください。
text 内容が、Hello world! になっているリソースがあります。
これが、@string/hello_world リソースの実態(定義元)です。

 

@string/hello_world リソースの初期内容は下記の通りです
<string name="hello_world">Hello world!</string>

2. hello_world リソースの内容変更
name 属性が "hello_world" の string 要素の text を
Hello world! から こんにちは、怒られない世界！ に変更してみてください。

メッセージを変更してみよう



　

メッセージを変更してみよう



　メッセージの変更(3)
 

3.リソース変更の確認
fragment_hello_practice.xml の Text タブを開き
右隣のPreview表示が、入力内容に変化していることを確認します。

 

TextView の text 属性にマウスカーソルをかざしても
Android Studio から怒られないことを確認してください。

 

【学んだこと】
@string/hello_world の実態は、
strings.xml の name 属性が hello_world の string 要素データである。
つまり stringリソースは、@string/ ＋ name 属性で指定できる。
以上は、リソースの基本ですので覚えてくださいね。

 

英語⇔日本語の切り替えをする場合、英語と日本語で name 属性が同じ stringリソースを定義して、
画面表示設定で、その stringリソースを利用すればリソース先を切り替えるだけで英語⇔日本語が対応できますから、
Android Studioがテキストの直書きを怒ったのです。

メッセージを変更してみよう



　

メッセージを変更してみよう

fragment_hello_practice.xml では

　「@stringリソースを使うべし」と

　　怒られません。

@stringリソース内容が、
メッセージに反映されています。

テキスト内容が”こんにちは、怒られない世界！”の
hello_worldという@stringリソースを定義します。



　今の画面には、メッセージしか表示されないので変化がありません。
画面にボタンを配置してみましょう。

HelloWorldアプリの画面表示を定義している、
app/src/main/res/layout/fragment_hello_practice.xml の
Design タブを開いてください。

 演習４） ボタンを配置してみよう



　

ボタンを配置してみよう

2.app/src/main/res/layout/
　 fragment_hello_practice.xmlを
　ダブルクリック 

3.fragment_hello_practice.xmlが
　 開くので、Designタブを選択 

1.左ツールウィンドウの
  Project 



　1. 画面にボタンを追加配置する。
Palette の Widgets から Button をマウスで選んで、
右隣のデバイスの画面中央にドラッグ＆ドロップしてください。

 

2. 画面のボタン配置を確認する。
Text タブを開き、右隣りのデバイスの画面中央に「New Button」というラベルのボタンが配置され、
エディタエリアのXML内容に、下記の Button 要素が追加されていることを確認します。
<Button
    android:layout_width="wrap_content"
    android:layout_height="wrap_content"
    android:text="New Button"
    android:id="@+id/button"
    android:layout_centerVertical="true"
    android:layout_centerHorizontal="true" />

 

【学んだこと】
画面にボタンを表示するには、Button 要素を使います。
画面にボタンを配置するには、Design タブでのドラッグ＆ドロップで行えます。
Paletteから、CheckBoxなど他のWidget（UIパーツ）を選んでドラッグ＆ドロップもできます。

ボタンを配置してみよう



　

ボタンを配置してみよう

1.Palette の Widget から
  Button を選択 drag して
  画面中央で drop

2.Textタブで
  画面内容定義のXMLに
  Button要素の追加を確認

3.画面にＢｕｔｔｏｎが
  追加されました

Text



　3. エミュレータで、ボタンをクリックしてみる
エミュレータを起動して、画面表示を確認してから
「New Button」ボタンを押下してください。

ボタンをクリックしても、何も反応が返らないないことを確認します。
「ボタンのクリックで何をするのか」をプログラミングしていないのですから当然です。

【学習ポイント】
ボタンを配置しただけでは、クリック時の反応が返りません。
ボタン押下時に反応するには、別途対処が必要になりますが、
どうすればよいのかを想像してみましょう。

ボタンを配置してみよう



　

ボタンを配置してみよう

試しにボタンをクリック 何も起こりません。
 

だって、何をするのか
プログラミングされて

いませんから。



　画面にボタンを配置しただけでは、
ボタンをクリックしても何も反応が起きませんでした。
 

ボタンのクリックで何かを行うためには、別途ボタン押下時の処理が必要と判かりましたので、
HelloPracticeアプリ画面の表示処理に、ボタン押下時の処理プログラムを追加します。

HelloPracticeアプリ画面の表示や動作の処理を定義している、
app/src/main/java/com.example.hellopractice.hellopracticeapplication/
HelloPracticeActivity.java を開いて下さい。

 演習５） ボタン押下でメッセージを出そう



　この演習で行うこと…

ここでは、ボタン押下でメッセージを表示するよう、
画面表示元である HelloPracticeActivity クラスの
PlaceholderFragment サブクラスの onViewCreated メソッドに、
以下のボタン押下時のアクションを指定するプログラムを入力します。

Button button = (Button) view.findViewById(R.id.button);
button.setOnClickListener(new View.OnClickListener() {
    @Override
    public void onClick(View v) {
        Toast.makeText(getActivity(), "クリック！", Toast.LENGTH_LONG).show();
    }
});

このプログラミング・コードの内容は、今は「おまじない」と思ってください。

ボタン押下でメッセージを出そう



　

ボタン押下でメッセージを出そう

2.app/src/main/java/
  com.example.hellopractice.hellopracticeapplication/
  HelloPracticeActivity.javaを
  ダブルクリック 

3.HelloPracticeActivity.javaが
　 開くので、下へスクロール 

1.左ツールウィンドウの
  Project 

4.onViewCreatedメソッドの
  演習を入力する箇所は、
  ソース下部にあります。



　ボタン押下時のメッセージ表示処理追加プログラミング
 
１． １行目の "Button button = (Button) view.findViewById(R.id.button);" の入力

初めに “Button “（スペース含む）まで入力してみましょう。
"android.widget.Button ? Alt + Enter" と指摘されませんか？

 

Android Studio が「Button は android.widget.Button のことなの？」と尋ねているのです。
ここでは、 Alt + Enter を入力してください。

 

すると、自動的に import android.widget.Button; がソース先頭あたりに追加されます。
これが、Android Studio(IntelliJ)でインテンションと呼ばれる、コード修正の提案機能です。

 

続いて、Button button = (Button) view.find まで入力すると
"findViewById(int id) view" が提案されますので Enter で採用しましょう。
これで Button button = (Button) view.findViewById() まで入力されました。

 

続いてカッコ内で R.id. まで入力すると "button" が提案されますので Enter で採用します。
最後に残ったカッコの後ろに  ;  を入力すれば、一行目の入力が完了しました。

ボタン押下でメッセージを出そう



　

ボタン押下でメッセージを出そう

ALT+Enter
Buttonのインポートが
追加されました。



　

ボタン押下でメッセージを出そう

E
nter

view.find まで入力すると
候補一覧が出ます。

選択した findViewById を
Enter で採用すると
コードが入力（補完）されます。



　

ボタン押下でメッセージを出そう

最後に ; を入力して
1行目の完成です。

E
nter

括弧内で R.id. まで入力して
リソース候補一覧を出します。

選択した button リソースを
Enter で採用して
コードを入力（補完）します。



　2． ２行目の "button.setOnClickListener(new View.OnClickListener() {"  の入力
初めに button.setOn まで入力してください。
"setOnClickListener(OnClickListener l) void" が提案されますので Entere で採用すると、
button.setOnClickListener(); まで入力されますが、
カッコに赤く下線が引かれて警告されていると思います。

 

次に、カッコの中にカーソルを移動して、"new "（スペース含む）を入力したら
CTRL+Space を入力してください。 (メニューバー > Code > Complection > Basic でも可)
"onClickListner(){...} (android.view.view)" が提案されますので Enter で採用します。

 

すると、一気に下記の内容が入力されます。
button.setOnClickListener(new View.OnClickListener() {
    @Override
    public void onClick(View v) {
        
    }
});

先ほどの CTRL+Space が、Android Studio のBasicコード補完機能です。

ボタン押下でメッセージを出そう



　

ボタン押下でメッセージを出そう

E
nter

button.setOn まで入力して
候補一覧を出します。

選択した setOnClickListener を
Enter で採用して
コードを入力（補完）します。



　

ボタン押下でメッセージを出そう

“new “まで入力したら
 CTRL + Space 
“new “まで入力したら
 CTRL + Space 

OnClickListener から
onClickメソッドまでを
一気に補完

E
nter

Basicコード補完機能で
候補一覧を出します。
Basicコード補完機能で
候補一覧を出します。

選択した sonClickListener を
Enter で採用して
コードを入力（補完）します。



　3． 残った Toast.makeText(getActivity(), "クリック！", Toast.LENGTH_LONG).show(); の入力
最後に onClick メソッドの中身を入力しましょう。

 

Toast. まで入力しましたら、
"Toast.makeText(Context context, CharSequence text, int dulation)... Toast"が
提案されるので Enter で採用して、 Toast.makeText() まで自動入力します。

続いてカッコ内で getA まで入力して "getActivity() Activity" の提案を Enter で採用して、
引数区切りの , を入力します。
メッセージは、そのまま "クリック!", を入力しましょう。
最後に Toast. まで入力し "Toast.LENGTH_LONG" の提案を Enter で採用すれば、引数入力の終了です。

 

まだ閉じカッコに下線がついて警告されていますので .s まで入力して "show() void" を Enter で採用すると、
自動的に末尾の ; まで補完されます。

 

以上でメッセージ出力行の
Toast.makeText(getActivity(), "クリック！", Toast.LENGTH_LONG).show();
…が完成しました。

ボタン押下でメッセージを出そう



　

ボタン押下でメッセージを出そう

Enter

Enter

Toast. まで入力して
候補一覧を出します。

選択した makeText を
Enter で採用して
コードを入力（補完）します。

getA まで入力して
候補一覧を出します。



　

ボタン押下でメッセージを出そう

E
nter

Toast. まで入力して
候補一覧を出します。

選択した LENGTH_LONG を
Enter で採用して
コードを入力（補完）します。

”クリック！”， を通常入力します。



　

ボタン押下でメッセージを出そう

E
nter

.s まで入力して
候補一覧を出します。

選択した show を
Enter で採用して
コードを入力（補完）します。



　4． ボタン押下でメッセージが出るか確認
エミュレータを起動して、画面表示を確認してから、「New Button」ボタンを押下してください。
今度は、「クリック！」と画面にメッセージが表示されたと思います。

プログラムしたコード内容は、ボタンのクリック時の処理先に、メッセージの出力処理を設定しています。
 

プログラミング用語で説明すると
「ボタン・オブジェクトのクリック・イベントリスナに、
　クリック・イベントの処理としてメッセージ出力を行うイベントハンドラを設定している」となります。

ソースコードの入力体験は、いかがでしたか
Android Studio は、コードの文脈に合わせてコード入力の提案や自動入力(補完)をしてくれる

　便利な IDE ですね。

ボタン押下でメッセージを出そう



　

ボタン押下でメッセージを出そう

ボタンをクリック

メッセージが
表示されました。



　演習５）の「おまじない」の１行目(*1)では、
ボタン・オブジェクトを画面(view)から findViewById メソッドで抽出しています。
(*1)"Button button = (Button) view.findViewById(R.id.button);"

 

では、ボタン・オブジェクトを特定した R.id.button は、どこで定義されているでしょう。
実は、R.id.button は、
画面表示を定義している fragment_hello_practice.xml に配置した Button 要素
<Button
    android:layout_width="wrap_content"
    android:layout_height="wrap_content"
    android:text="New Button"
    android:id="@+id/button"
    android:layout_centerVertical="true"
    android:layout_centerHorizontal="true" />
…の id 属性の内容(button)を利用しているのです。

 

画面には、ボタンやテキストなど複数のUIパーツ(Wiget)が配置できます。
各Widgetが特定できるよう id 属性の内容は、固有の値となるよう注意してください。

id は、オブジェクトを特定する
大切な識別子

発展
学習



　Android には、ログ出力を行う logcat と呼ばれる標準の API があります。
logcat は、アプリ開発時のデバッグ出力などに役立ちますので実践してみましょう。
ログ出力は、画面下の Android DDMS ツールウィンドウ内の logcat に表示されます。

それでは、演習５）のボタン押下時の onClick メソッドでの
Toast を使ったメッセージ出力の下に、下記のログ出力を追加してください。

 

Log.d("Practice", "クリック・ログ出力！");
 

Ancdoid Studio のコード修正提案の採用やコード補完に慣れましたか？
入力が終わりましたら、ナビゲーション・ツールバーの Run ボタンをクリックしてアプリを実行しましょう。

 

Android DDMS ツールウィンドウの logcat に、
ボタン押下とともに"クリック・ログ出力"が出力されることを確認してください。

　　　　　　　　　　入力したコードの概要は、ｌogcat へのデバッグ・レベルでのメッセージ出力となっています。

 メッセージと一緒に Log を出力しよう
発展
学習



　

 メッセージと一緒に Log を出力しよう
発展
学習

Logのインポート
追加にも注意

Logのレベルは、
Verboseに

メッセージと同時に
ログ出力されます

Android DDMS 
ツールウィンドウを
開いてください



　メッセージやログを出力するだけでは、物足りませんか？
Android には、他のアプリとの連携を行う Intent という仕組みがあります。
ここでは、Intent を使って Webブラウザで Google を開いてみましょう。
（Intentの仕組みや概念などは、長くなるので触れません…ごめんなさい）

それでは、演習５）のボタン押下時の onClick メソッドでの
Toast を使ったメッセージ出力の下に、下記のWebブラウザ連携を追加してください。

 

Intent intent = new Intent(Intent.ACTION_VIEW, Uri.parse("http://google.co.jp/"));
startActivity(intent);

 

アプリを実行して、ボタン押下とともにブラウザが起動することを確認しましょう。

メッセージと一緒にWebページを開こう
発展
学習

http://google.co.jp/


　

メッセージと一緒にWebページを開こう
発展
学習

IntentやUriの
インポート追加
にも注意

ボタンのクリックから
メッセージが表示され
Webページの表示に
続きます。



　この演習サンプルは、皆さんも新規作成した HelloWorld アプリを元に作られています。
参考用にオリジナルの HelloWorld アプリのソース・ファイルを original_copy に保管しました。
(オリジナルと現在のファイルの区別がつくよう、オリジナルの拡張子を .original にしています。)

Android Studio では、ファイル内容の比較もできますので、オリジナルとの変更を確認しましょう。
 

例 Activyti の変更をチェックする場合
1. Project ツールウィンドウで  HelloPracticeActivity.java を選択します。
2. CTRL キーを押しながら HelloPracticeActivity.java.original を選択して、右クリックします。
3. ポップアップ・メニューから、Compare Two File を選択します。

ファイル比較ダイアログが開き、両者の違いが表示されます。

アプリのコード変更を確認しよう
発展
学習



　

アプリのコード変更を確認しよう
発展
学習

ファイル比較ダイアログで、
変更を比較確認できます。

比較元と比較先を
選択します

Compare Two Files
を右ポップアップで選択



　PCを使ったアプリの動作確認（デバッグ）について
 

本演習では、エミュレータを使って動作確認（デバッグ）をしてみましたが、
エミュレータの代わりにPCと実機をUSBケーブルでつないでアプリの動作確認（デバッグ）をすることもできます。
 

ただし、PCと実機をUSBケーブルでつないでデバッグを行う場合、
「Android USBドライバ」と「開発者向けオプションでのUSBデバッグ指定」が必要になります。
上記の補説については、次ページ以降を御参照ください。

実機でデバッグしてみる
発展
学習



　Android USB デバイスドライバのインストールについて
 

１． Windows 7 の場合
実機とPCをUSBで接続した際に、「ドライバが見つかりません。」と通知された場合の対処例
ネット検索などで実機用のAndroid USBドライバがあった場合は、そちらを優先してください。
残念ながら、全ての実機が下記方法で対処できるとは限りません。

 

１ コントロールバネルから、システムのデバイスマネージャーを開きます。
２ デバイスマネージャーで、実機が「ほかのデバイス」（ドライバ不明のデバイス）となっていたら、

USBドライバのインストールを行うため、ドライバーソフトウェアの更新ダイアログを開きます。
３-1 ドライバーソフトウェアの検索を利用する場合は、

ドライバー検索場所を Android Studio インストール先￥sdk\extras\google\usb_driver に指定して、
USBドライバーのインストールを行います。

 3-2 デバイスドライバーの一覧を利用する場合は、
Android Device を選択して「次へ」クリックで、ドライバーソフトウェアの更新ダイアログに進み
Android Composite ADB Interface を選択して、
USBドライバーのインストールを行います。

実機でデバッグしてみる
発展
学習



　Android USB デバイスドライバのインストールについて
 

2． Linux の場合
実機とPCをUSBで接続してコンソールで、adb devices を実行した際のリストが空の場合は、
Android Developers > tools > Using Hardware Devices に従って、
/etc/udev/rules.d/51-android.rules ファイルに実機のUSB Vender Id 行を追加してください。

実機でデバッグしてみる
発展
学習

http://developer.android.com/tools/device.html


　開発者向けオプションでのUSBデバッグ指定について
 

1． 実機がICS（Android 4.0.3）以前の場合
Android の設定画面に「開発者向けオプション」という
開発者（デベロッパー）用の設定項目が標準でありますので、
「開発者向けオプション」から、デバッグ項目にある「USBデバッグ」のチェックをONにしてください。

2． 実機がJelly Bean（Android 4.1, 4.2, 4.3）以降の場合
「開発者向けオプション」は、一般の人が間違って利用しないよう初期状態だと非表示になりました。

 

「開発者向けオプション」を表示するには、
Android 設定画面から「端末情報」を開き「ビルド番号」を連続タップしてください。
連続タップを続けると「これでデベロッパーになりました！」と表示され開発者（デベロッパー）になります。

 

上記の操作以降は、Android の設定画面に「開発者向けオプション」が表示されますので、
「開発者向けオプション」から、デバッグ項目にある「USBデバッグ」のチェックをONにしてください。

実機でデバッグしてみる
発展
学習



　1. プロジェクトのビルド
ナビゲーション・ツールバーの Make Project ボタンをクリックして、プロジェクトのビルドを行いましょう。
画面下部のツールウィンドウに Gradle Console が開き BUILD SUCCESSFUL と表示されましたら、
プロジェクトのビルドに成功です。

 

2. トラブルシュート
ビルドに失敗しましたら、先ずは、Gradle Console のエラーメッセージを確認してください。
適切に設定したつもりなのにビルドに失敗したときは、　以下を試してみてください。

 

1. Sync Project With Gradle File ボタンをクリックして、
プロジェクト構成設定とGradle設定の同期をとってみる。

2. メニュー > Build > Clean Project 選択して、プロジェクトを初期化してみる。
3. メニュー > Invalidate Caches / Restart... を選択して、キャッシュをクリアして再起動してみる。

（要するに「リセットボタンを押す」ですね。　これは、エラーやフリーズなど、ビルド以外にも応用できます）

4. バージョンアップを待ちましょう
ネット検索で類似の問題がないかを検索して、解決法が見つかることもありますが、
Android Studio は、まだBETA版ですのでバグの場合もあります…。

プロジェクトのビルドについて
発展
学習



おさらい

今日できるようになったこと
● Android Studioを使って、Androidのアプリを　

新規作成・実行できるようになった。
● サンプルコードをインポートできるようになった。
● レイアウトをいじったりボタンを配置して

クリック動作を定義できるようになった。



演習資料（２）
Android Studio でのアプリ開発

本演習は、これで終了です

おつかれさまでした

おつかれさまでした



　本演習資料作成にあたり、以下のサイトを参考にしました。

1. Android Studio 全般
Android Studio最速入門～効率的にコーディングするための使い方
http://gihyo.jp/dev/serial/01/android_studio
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